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Super Task Man is the ultimate task manager that allows you to launch programs, manage both hidden 
and visible tasks, and configure your task manager environment according to your own preferences.
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General Information
Introducing Super Task Man (A MUST READ TOPIC)
Why Register?
Register Super Task Man
ASP Ombudsman Statement

Information on Super Task Man Features
Launching Applications With The Run Command
Setting Run History Preferences
Setting Task List Preferences
Setting Options
Using the Launch Setup Dialog
Adding or Editing Launch Menu Items
Defining the Windows Default Printer
Performing Multi-Selection Operations
Working With Hidden Windows
Exiting Windows from Super Task Man
Replace Task Manager with Super Task Man



Introducing Super Task Man

Super Task Man is designed as a replacement for the standard Task Manager.    Super Task Man contains
all the functionality of the standard Task Manager with added features such as a run command with 
history, multi-select task list, default printer setup, and an enhanced Tile and Cascade option to name just 
a few. Super Task Man is the utility every Windows user will not want to be without!

Move the mouse cursor over any area of the following dialog until the cursor changes to a hand with a 
pointer. Then click the left button to display more information about the control.



ASP Ombudsman Statement

This program is produced by a member of the Association of Shareware Professionals (ASP).    The ASP 
wants to make sure that the shareware principle works for you.    If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help.    The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



Why Register?

Super Task Man is a "shareware program" and is provided at no charge to the user for evaluation.    The 
essence of "user-supported" software is to provide personal computer users with quality software without 
high prices, and yet to provide incentive for programmers to continue to develop new products.

If you find this program useful and find that you are using Super Task Man and continue to use Super 
Task Man after the 10 day trial period, you are required to make a registration payment of $15 to Joe 
Herrera.

Registration for Super Task Man does provide some generous benefits:
1) You will receive a registered copy of the latest version of Super Task Man without the registration 

reminder message.

2) Registered users are sent the latest version plus receive the next upgrade FREE!

3) Entitles you to one hour free phone support for 90 days.    You pay for the phone call.

4) Gets you on user mailing list so you are occasionally notified of updates and other products that 
become available by the author.

ATTENTION!: As an added BONUS!!!    Everyone who registers Super Task Man will also receive 3 
additional window programs created by the authors of Super Task Man:

STMALARM: A message alarm program.    Set alarms to display messages.    Set the date and time for 
an alarm.    A Visual Basic application that only requires a small amount of memory when 
not active.

STMCAL: A window calendar program.    This calendar allows you to move forward and backward 
through months or years.    Jump to any particular month or year.    It is even an active 
calendar while it is iconic (displays a visual layout of the month with the current day 
highlighted).    It also saves it's window position.

STMHIDE: Use this little application to start an application in a hidden state.    Just the past the 
command line parameters to this application an it will be started as a hidden application 
that can be listed with Super Task Man.

WHY WAIT???
REGISTER      TODAY      AND      RECEIVE      FOUR

PROGRAMS      FOR      THE      PRICE      OF      ONE!!!



Registration for Super Task Man

To print this form, select Print Topic from the File menu.

Ordering Information/Order Form

Super Task Man(c) 3.01 Registration Form/Invoice.    Please remit to:

        Joseph A. Herrera
        P.O Box 866125
        Plano, TX 75086-6125

You can order by sending a check and this order form to the address
above.    Payments must be made in US dollars.

Select media type:  5.25" Disk ____                3.5" Disk ____

Super Task Man 3.01 @ $15.00 each    x    _____ = $___________

Super Group        1.02 @ $15.00 each    x    _____ = $___________

***SPECIAL OFFER***
For each registration of Super Task Man, you can have a registered version
of Super Group for $5.00.    This offer is only valid with registrations to
Super Task Man.

Super Group Special offer: @ $5.00 each x _____ = $___________
(Remember each $5 registration to Super Group must accompany a $15
 registration to Super Task Man)

Shipping & handling (outside USA)                  $5.00 + $___________
(S&H only required on Overseas orders)

                                                                        Total
payment $___________

    Name:          __________________________________________________

    Company:    __________________________________________________

    Address:    __________________________________________________

    City, State, Zip:    _________________________________________

    Country: ___________________________________________________

 Signature:    ___________________________Date:_________________

Where did you get your copy of Super Task Man from ?

______________________________________________________________

Comments:



Launching Applications With The Run Command

The Run Command provides an immediate access to launching commands or documents.    No need to 
search for a window that provides this function any more.    The Run Command also provides a history list
that can contain from 1 to 50 previously executed commands.

Command Line
Set focus to this box and fill it in by any of the following methods:
* Click the arrow next to the edit box (or press Alt+down arrow) to select from a list of previously executed

programs or documents.
* Type the beginning of a previously launched command (ex. CO for CONTROL), followed by the down 

arrow and the history command that resembles the string the closest will be displayed.
* Type the full path and filename of the program or document you want to run or load.
* Use the Browse button to select a directory and file.
* Type the filename of the program or document you want to run or load, a space, and any program 

parameters you want to pass to the program when it runs.

Run State
Select the state to initially start the application or document that is defined in the command line.    The 
application or document can be started in a Normal, Maximized, Minimized, or Hidden state.

Browse...
This displays a standard Browse dialog box to help you locate the program or batch file you want to run.

Run
Executes the file displayed in the Run Command edit box.

See Also
Setting Run History Preferences



Defining the Windows Default Printer

Super Task Man provides an option for defining the Windows default printer.    There is no need to start 
the Control Panel to perform this operation.    This allows those who change the default printer quite 
frequently to perform this task much quicker.

Changing the Default Printer:
From the list of installed printers, select the printer you wish to make the default printer and the click on 
the OK button.    Double-clicking on the selected printer will produce the same action.    To set options 
specific to the selected printer, click on the Setup button and set the options as needed.

Note: For specific information about the printer-driver options, choose the Help button or press F1 while 
using the Setup specific dialog box.



Performing Multi-Selection Operations

The Task List is and Extended Selection list box.    To select a group of tasks that are next to each other, 
hold down the left mouse button while dragging the cursor.    To select a group of tasks that are spaced 
apart, hold down the Ctrl key while clicking on a task with the left mouse button.

Switch To
Selecting more than one task from the task list and then clicking on the Switch To button restores all 
the selected tasks.

End Task
Selecting more than one task from the task list and then clicking on the End Task button terminates all 
the selected tasks.

Show/Hide
Selecting more than one task from the task list and then clicking on the Show/Hide button shows or 
hides the selected tasks based on their current window state.

Minimize
Selecting more than one task from the task list and then clicking on the Minimize button minimizes all 
the selected tasks.

Tile
Selecting more than one task from the task list and then clicking on the Tile button tiles the selected 
tasks.    Any DOS windows that are in an icon state are ignored to avoid restoring a full screen DOS 
window.    Windows can be tiled either vertically or horizontally.. The standard tile method is vertically.    
In order to tile the windows horizontally, hold the shift key down while clicking on the Tile button.

Cascade
Selecting more than one task from the task list and then clicking on the Cascade button cascades the 
selected tasks.    Any DOS windows that are in an icon state are ignored to avoid restoring a full screen 
DOS window.



Setting Run History Preferences

Use the Run History dialog to define the history size and remove unwanted commands from the run 
history list.

Setting the History Size
The history size indicates the number of successfully launched applications or documents from the Run 
Command.    The history size can range from 1 to 50 commands.    Super Task Man is optimized to load 
the history list only when the list is requested.    This allows large history lists to be stored without 
affecting load time for Super Task Man.

Removing History Commands
To remove any unwanted history commands from the history list, select the history command you want 
to remove and then click on the Delete button.    The history list is and Extended Selection list box.    To
select a group of history commands that are next to each other, hold down the left mouse button while 
dragging the cursor.    To select a group of commands that are spaced apart, hold down the Ctrl key 
while clicking on a history command with the left mouse button.    To remove the existing history list, 
click on the Clear List button.

See Also
Setting Task List Preferences
Setting Options



Setting Task List Preferences

Use the Task List dialog to define settings for use with the Super Task Man task list.

Setting Task List Display Preferences:
Use the Sort By and Sort Order options to define the display preferences for the Task List contents.    
To sort the tasks by their window title, click on the Window Title radio button.    To sort the tasks by their
window order (the order that they appear with Alt-Tab), click on the Window Order radio button.    Use 
the Window Order option to list the tasks is Ascending or Descending order.

Setting Task List Content Preferences:
Use the check boxes in the Task List dialog to define the contents listed in the task list of Super Task 
Man.    Super Task Man is capable of displaying hidden windows within the task list.    Use the Show 
Hidden Windows check box to toggle the selection of showing hidden windows or not.    The additional 
check box, Show 0 Size Windows, can be used to display windows of 0 size in height or width.    Using
this check box provides an addition level of filtering windows that can be displayed within the task list.

Setting the Icon Size:
Use Task Icon Size option to define the icon height for each task listed in the task list window.    Each 
value represents the percentage (%) size to make the icon.    100% indicates a normal size icon, 50% 
indicates an icon have the normal size, and None indicates that no icon is displayed next to each task.

See Also
Working With Hidden Windows
Setting Run History Preferences
Setting Options



Setting Options

Use the Options dialog to setup general preferences for use with Super Task Man.

Setting Tile/Cascade Preference:
Super Task Man supports a Tile and Cascade feature that no other Window product is currently capable
of supporting.    By selecting the Enhanced radio button, Super Task Man works together with 
selections made from the task list when performing the Tile/Cascade operation.    Also, by clicking on 
the Use Icon Space checkbox, Super Task Man uses the entire desktop for the Tile/Cascade operation.
To perform Tile/Cascade operations like the standard task manager, select the Standard radio button.

Tiling Preference:
To define how windows are tiled, use the Tile Windows option.    To tile the windows horizontally, select 
the Horizontal radio button.    To tile the windows vertically, select the Vertical radio button.

Setting the Default Focus:
The default focus relates to which control will have the initial focus when Super Task Man is displayed.   
To have the default focus set on the edit box for the run command, click on the radio button assigned to 
Command Line.    To have the default focus on the Task List as the traditional Task Manager, click on 
the radio button assigned to Task List.

3-D Appearance
To use Super Task Man with 3-D controls for a more custom appearance, select the Use 3-D Controls 
checkbox.

See Also
Setting Run History Preferences
Setting Task List Preferences



Working With Hidden Windows

Super Task Man provides a unique feature that allows you to show or hide a selected window based on 
it's current state.    Hiding tasks is an easy way to unclutter your windows desktop if a task is taking 
desktop space and you don't want to terminate it.    When your ready to use the hidden window, just bring 
up Super Task Man and select the hidden window from the task list.

To display hidden tasks, just click on the Show Hidden Windows checkbox.    The Task list will then display
both visible tasks and hidden tasks.    Visible tasks are preceded with "+" in front of their task name, 
hidden tasks are preceded with "-" in front of their task name, and zero sized windows are preceded with 
a "0" in front of their task name.

Note: The window titles are not prefaced with any symbols when hidden tasks are not displayed at all.

See Also
Setting Task List Preferences
Performing Multi-Selection Operations



Exiting Windows from Super Task Man

Super Task Man provides a useful feature for exiting Windows.    This feature supports several methods 
for exiting Windows.    From restarting Windows to performing a reboot of the system.    Use this feature to
have quick access to the Exit Windows command or to restart your Windows session after it has become 
unstable (UAE or GP Fault).

To Exit Windows:
From the File menu select Exit Windows.    This will display an Exit Windows dialog.

* To just exit back to DOS, click on the Exit to DOS button.    This will perform a standard Windows 
shutdown.    If any applications have been modified, you will receive message boxes asking whether 
to save the changes or not.

* To exit to DOS and immediately restart Windows, click on the Restart Windows button.    This will 
also perform a standard Windows shutdown and then restart Windows.

* To just reset the computer, click on the Reboot System button.    This will perform the same action 
as pressing the reset button on your computer.

* To cancel the Exit Windows request, click on the Cancel button.



Replace Task Manager with Super Task Man

Super Task Man is designed as a replacement to Windows' Task Manager.    Two methods are provided 
for replacing the current TASKMAN.EXE with SUPERTM.EXE:

Method 1
1) Run SUPERTM.EXE from Program Manager or File Manager by selecting RUN from the FILE menu 

(this may be the last time you will ever do this again).

2) Click on the Control Menu located on the top left part of the Super Task Man window and select 
About...

3) Click on the Replace TASKMAN.EXE check box in the about box.

4) Click on the OK button in the About dialog box.

5) Select Exit Windows from the File menu.

6) Click on the Restart Windows button.

7) Windows will be restarted automatically.    Once Windows is restarted, you can access Super Task 
Man by double-clicking on the desktop or pressing Ctrl-Esc on the keyboard.

Note: Make sure Super Task Man is stored in a directory on the path or it will not run.

Method 2
1) Edit SYSTEM.INI located in your Windows directory with a text editor.

2) Under the section labeled [boot] add the following line TASKMAN.EXE=SUPERTM.EXE

3) Save the changes to SYSTEM.INI

4) Shut-Down and restart Windows



Using the Launch Setup Dialog
The Launch Setup dialog allows you to create a custom Launch menu for quick access to programs that 
you use the most.    Use the Launch Setup dialog to perform maintenance on your custom Launch menu.

To Add a New Launch Item:
1) Click on the Add button.    The Add Menu Item dialog will be displayed.
2) Enter the menu text and command line information

To Edit an Existing Launch Item:
1) Select the menu item to edit and then click on the Edit button.    The Edit Menu Item dialog will be 

displayed.
2) Update the information for the menu item.

To Delete a Launch Item:
1) Select the menu item to delete and then click on the Delete button.

To Change the Position of a Launch Item:
1) Select the menu item whose position will be changed.
2) To move the menu item up, click on the Move Up button.    To move the menu item down, click on the 

Move Down button.



Adding or Editing Launch Menu Items
Use the Add/Edit Menu Item dialog to create a new launch menu item or to update an existing one.

To create a new launch menu item:
1) Enter the menu item text describing the command to run.    For example, to edit your WIN.INI file with 

NOTEPAD, enter the description Edit WIN.INI.
Tip: To define an accelerator key for the menu so that a letter from the menu is underlined, enter an & 

before the letter you want to make the accelerator key.    Using our example again, we could add 
the & just before the E for Edit.    This will cause the command to run if you select when the menu 
is displayed.

2) Enter the command line to execute.    If you don't know the full path of the command to run and the 
command is not located on the path, use the Browse button to locate the command to place in the 
command line.



Super Task Man Menu
The Super Task Man menu provides access to setting the default printer, exiting Windows, and setting 
Super Task Man configuration preferences.    Super Task Man now supports a configurable launch menu 
for running your most frequently accessed applications.



Run Command Line
Use the Run Command line to launch applications or documents.    You can also launch documents by 
passing the document name to an application (ex. notepad c:\autoexec.bat) if the application is capable of
accepting parameters.

See Also
Launching Applications With The Run Command



Run State Combo Box
Use the Run State combo box to set the initial window state of a launched application.

See Also
Launching Applications With The Run Command



Browse Button
The Browse button displays a Windows common dialog box that allows you to browse specific directories
and drives for an application or document.

See Also
Launching Applications With The Run Command



Run Button
The Run button initiates the application or document launch once an application or document has been 
specified.

See Also
Launching Applications With The Run Command



Task List
The task list is capable of displaying all visible applications that are currently running just like the standard
task manager.    Unlike the standard task manager, the task list is also capable of showing hidden 
applications.

Super Task Man supports multi-selections from the task list.    The Switch To, End Task, Hide/Show, 
Tile, and Cascade buttons support the multi-selection feature.

See Also
Setting Task List Preferences
Peforming Multi-Selection Operations



Switch To Button
Activates the currently selected task(s).    Double clicking on the task in the task list will produce the same 
action.    Super Task Man supports multi-selections from the task list.

See Also
Setting Task List Preferences
Peforming Multi-Selection Operations



End Task Button
Terminates the currently selected task(s).    Super Task Man supports multi-selections from the task list.

See Also
Setting Task List Preferences
Peforming Multi-Selection Operations



Show/Hide Button
Shows or Hides the currently selected task(s) based on their current state.    Super Task Man supports 
multi-selections from the task list.

See Also
Setting Task List Preferences
Peforming Multi-Selection Operations



Minimize Button
Minimizes the currently selected task(s).    Super Task Man supports multi-selections from the task list.

See Also
Peforming Multi-Selection Operations



Tile Button
Performs a Standard tile operation.    If the Enhanced Tile/Cascade option is selected, then the tasks 
selected in the task list are tiled.    Windows can be tiled either vertically or horizontally.. The standard tile 
method is vertically.    In order to tile the windows horizontally, hold the shift key down while clicking on 
the Tile button.

See Also
Setting Task List Preferences
Setting Options
Peforming Multi-Selection Operations



Cascade Button
Performs a Standard cascade operation.    If the Enhanced Tile/Cascade option is selected, then the tasks
selected in the task list are cascaded.

See Also
Setting Task List Preferences
Setting Options
Peforming Multi-Selection Operations



Arrange Icons Button
Arranges all applications that are in an icon state along the bottom of the desktop similar to the standard 
task manager.



Status Bar
The status bar provides continuous information on the number of tasks currently running, the current 
number of selected tasks, and the Windows resources information.




